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Introduction

Introduction

KUARIO Gateway is a solution to give a known third-party application access to the KUARIO payment service. It acts as
a KUARIO Order Terminal, and sits between the third-party solution and the KUARIO Cloud Payment service. Third-
party solutions can request payment transactions via the KUARIO Gateway.

This manual explains what the KUARIO Gateway solution offers. It will also help you to install and configure the
KUARIO Gateway in combination with the Uniflow solution.

Usage
Registered users of the Uniflow solution are required to pay for their print products. Without the KUARIO Gateway,
there is a pre-paid balance stored in Uniflow. When a user prints using the Uniflow solution, an amount will be
removed from the Uniflow balance. The downside to this, is that the users can not use these funds outside of the
Uniflow solution.

The KUARIO Gateway enables users to use their KUARIO funds in the Uniflow print solution environment, as well as in
all other KUARIO enabled pay points. The KUARIO Gateway is authorized to view a users funds within KUARIO and to
make a transaction from a users KUARIO balance to the KUARIO Gateway's Merchant. Users that want to use their
funds within the Uniflow solution have to accept an agreement with this Merchant via a KUARIO Membership.

When a user has accepted the Membership, the user's KUARIO funds are linked to the KUARIO Site where the
Gateway is registered. The last known amount of KUARIO funds is visible in Uniflow credit as an external balance.
These funds can now be used to pay for jobs in Uniflow. The balance will be transferred from the KUARIO Account of
the user to the KUARIO Merchant.

Note: It is not possible to add credit to a KUARIO Account directly from Uniflow.

Note: It is not possible to 'see’ your KUARIO funds accurately in Uniflow as the user's KUARIO transactions on
other sites cannot be monitored. The KUARIO Funds are shown as known the last time a user was 'seen’ by the
system.
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5

Architectural overview

The payment architecture consists of the following parts:
B The KUARIO Gateway
® UniFlow User DB

B KUARIO Cloud Payment service, with KUARIO users.
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Installation

Acquiring the software

The KUARIO Gateway software is available. Please contact KUARIO Support (support@KUARIO.com) to receive a copy
of the software.
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KUARIO Gateway

The KUARIO Gateway is the link between the KUARIO plug-in and the KUARIO Cloud Payment service.
To use the KUARIO Gateway plug-in, the KUARIO Gateway should be running.
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Installing the KUARIO Gateway
The KUARIO Gateway is installed by following these instructions:
1. Start the KUARIO Gateway Setup executable (double-click the KUARIOGatewaySetup-<version>.exe).
2. Follow the Setup instructions. Please remember the installation path (usually at C\Program Files\KUARIO\Gateway
), as this is required in one of the following steps.

Setup - KUARIO Gateway For ¥Soft 4.0.0 - X Setup - KUARIO Gateway For UniFlow 4.0.0 - X
License Agreement Select Destination Location
Please read the following important information before continuing. Where should KUARIO Gateway For UniFlow be installed?

Please read the following License Agreement. You must accept the terms of this . _ . .
agreement before continuing with the installation. Setup will install KUARIO Gateway For UniFlow into the following folder.

END-USER LICENSE AGREEMENT A To continue, dick Nesct. TF you would ke to select a different folder, dick Browse.
'THE SOFTWARE IS COPYRIGHTED AND LICENSED BY KUUARIO BV (NOT SOLD). BY .
PURCHASING THE SOFTWARE, YOU ARE ACCEPTING AND AGREEING TO THE S Browse...
TERMS OF THIS LICENSE AGREEMENT, THIS LICENSE AGREEMENT REPRESENTS
'THE ENTIRE AGREEMENT CONCERNING THE SOFTWARE, BETWEEN YOU AND
KUARIO BV, (REFERRED TO AS "LICENSOR'), AND IT SUPERSEDES ANY PRIOR
PROPOSAL, REPRESENTATION, OR UNDERSTANDING BETWEEN THE PARTIES.

1, License Grant, Licensar hereby grants to you, and you accept, a nonexclusive
license to use the software in machine-readable, object code form only, foruse v

()1 accept the agreement
(@)1 do not accept the agreement At least 10,4 M8 of free disk space is required.

Nex Cance ek Conce

At this step itis possible to enable a link between the gateway and MS Active Directory. Enable this if you need to put
information in the AD (Active Directory) or if you need information from the AD.

Tick the box at KUARIO AD Connector Service, if you need a connection between AD and KUARIO Gateway.
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Setup - KUARIO Gateway For UniFlow 4.0.0 - x
Select Components

Which components should be installed?

Select the components you want to instal; dear the components you do not want to
install. Click Mext when you are ready to continue.

KUARIO Gateway For UniFlow
] KUARIO AD Connector Service

Current selection requires at least 10,4 MB of disk space.

Setup - KUARIO Gatewsay For UniFlow 4.1.0 — x Setup - KUARIO Gateway For UniFlow 4.0.0 - x
Select Additional Tasks Ready to Install
Which additional tasks should be performed? Setup is now ready to begin installing KUARIO Gateway For UniFlow on your
computer.
Select the additional tasks you would like Setup to perform while installing KUARIO Click Install to continue with the installation, or dick Back if you want to review or
Gateway For UniFlow, then dlick Next, change any settings.
Enable User Import Gateway Destination location:

C:\Program Files\KUARIO\Gateway
Enable Payment Gateway
. Setup type:
Enable Print Gatzway KUARIO Gateway For UniFlow

Selected components:
KUARIO Gateway For UniFlow

Additional tasks:
Enable Payment Gateway
Enable Print Gateway

Back Cancel Back Tnstal Cancel

Setup - KUARIO Gateway For UniFlow 4.0.0 -

Completing the KUARIO Gateway
For UniFlow Setup Wizard

Setup has finished installing KUARIO Gateway For UniFlow on
your computer. The application may be launched by selecting
the installed shortuts,

Click Finish to exit Setup.

3. After finishing the Setup, please verify that the Gateway is running. There should be a KUARIO icon in the system
tray of Windows.

Install on a separate machine

For a more resilient solution and a faster user experience, it isrecommended to install the KUARIO Gateway on the
same machine as the external system.
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NTWare UniFlow

NTWare UniFlow can be directly connected to the gateway, you just need to configure it correctly.

We just need to import the correct certificates into "Trusted Root Certification Authorities certificate store”.

Installing the trusted root certificates
1. Go to the KUARIO Gateway folder (C\Program Files\KUARIO\Gateway)
2. Findthe certificates 'KUARIO.crt' and KUARIORootCA crt. Follow the rest of the procedure for both these files.

Program Files » KUARIO > Gateway

Mame Date modified Type Size
documentation 04-Feb-22 14:43 File folder
locale File folder
logs File folder

[ cAStore.pem PEM File

5 KUARIO.crt Security Certificate

[ KUARIO.pem PEM File
KUARIOGateway.exe Application
KUARIOGatewayGUl.exe Application

5l KUARIORootCA.crt Security Certificate

%] libeay32.dIl Application exten...
2] ssleay32.dil 1-Sep 05 Application exten...
2 unins000.dat 04-Feb-22 14:43 DAT
unins000.exe 04-Feb-22 14:43 Application 910 KB

3. Double-click the "crtfile.
4. When the certificate window opens, choose Install Certificate... The Certificate Import wizard appears.

n  Certificate x

General Details Certification Path

§ Certificate Information

This certificate is intended for the following purpose(s):
» All application policies

Issued to: KUARIOB.V.

Issued by: KUARIO

Valid from 05-Aug-19 to 05-Aug-43

Install Certificate... | | Issuer Statement

5. Inthe wizard, choose Next.

o Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to & certificate store,

A certificate, which is issued by a certification autherity, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

Store Location
(O Current User
(®) Local Machine

To continue, dick Next.

[ SNt || concel
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https://docs.microsoft.com/en-us/windows-hardware/drivers/install/trusted-root-certification-authorities-certificate-store

6. Confirm the UAC dialog of Rundll32 with Yes.

R

i
-

7. Then, when you are prompted for the Certificate Store, choose Place all certificates in the following store. Select
the Trusted Root Certification Authorities store.

bl
€ L¥ Certificate Import Wizard
Certificate Store

Certificate stores are systam areas where certificates are kept.
Windows can automatically select a certificate store, or you can specify a location for
the certificate.

(®) Automatically select the certificate store based on the type of certificate

(CPlace all certificates in the following store

Certificate store:
Browse...

8. Complete the remaining steps of the wizard and click Finish.

ped
& ¥ Certificate Import Wizard
Completing the Certificate Import Wizard
The certificate will be imported after you dick Finish.
You have specified the following settings:
Sas| Automatically determined by the wizard
Content Certificate

9. Confirm the success message.

Certificate Import Wizard X

o The import was successful,

10. Upon completing the wizard, you next want to add the certificate snap-ins using the Microsoft Management
Console (MMC).
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Adding certificate snap-ins

1. Launch MMC (mmc.exe).

2. Choose File > Add/Remove Snap-ins.
3. Choose Certificates, then choose Add.

B Consolel - [Cansole Root]

Avalable snap-ins:

Snap-n

=1 ActiveX Control

[T suthorization Manager
tificates

. Component Services
A Computer Managem. ..
evice Manager

= Disk Management

{2l Event viewer

"I Folder

1=/ Group Policy Object ...
B, 0 Security Moritor
B, 1P Security Policy M...
%1 Link to Web Address
= .. -

Vendor

Microsoft Cor
Microsoft Cor

Microsoft Car...
Microsoft Cor...

Microsoft and...
Microsoft Cor...
Microsoft Car...

Microsoft Cor...

Selected snap-ns:

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ns. For
extensible snap-ins, you can canfigure which extensions are enabled.

[ console Root

Description:

Edit Extensions...

Remove

Move Up

Move Down

Advanced...

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

Cancel

4. Choose My user account.
5. Click 'Finish'.

Certificates snap-in x

This snap-n will always manage certificates for:
(®) My user account
() Senvice account

() Computer account

<Back Cancel

6. Choose Add again and this time select Computer Account.

7. Click 'Finish'.

Certificates snap-in X

This snap-n will always manage certificates for:
() My user account
() Senvice account

(®) Computer account

< Back Next > Cancel

11 - KUARIO Gateway - https.//kuario.com
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8. Move the new certificates from the Certificates-Current User > Trusted Root Certification Authorities into

Certificates (Local Computer) > Trusted Root Certification Authorities.

Trusted Root Certification Authorities store contains 81 certificates.

Consolel - [Console Reot\Certificates - Current User\Trusted Root Certification Authorities\Certificates] X
File Action View Favourites Window Help & %
2 nE dBIXREEIH
7 Console Root A || Issued To Issued By Expiration Date  Intended Purposes  Friendly Name Status  C* || Actions
v & Cmp‘f‘“‘e‘" Current User [ GeoTrust Primary Certification .. GeaTrust Primary Certification Au..  17-Jul-36 Client Authenticati..  GeoTust Certificates -
ersonal
- GeoTrust Primary Certification ...  GeoTrust Primary Certification Au...  19-Jan-38 Client Authenticati.. GeoTrust Primary C... .
« [ Trusted Root Certification Authorities 5l o e o e ' L " More Actions 4
T [55) GeaTrust Primary Certification ... GeoTrust Primary Certification Au... 02-Dec-37 Client Authenticati.. GeoTrust Primary C...
ertificates
E;terprisETrust = GlebalSign GlobalSign 18-Mar-29 <Al «None> KUARIO -
=) Intermediste Certification Authorities 5] GlobalSign GlobalSign 18-Mar-28 Client Authenticati.. GlobalSign Root CA... More Actions »
| Active Directory User Object Ll GlobalSign GlebalSign 13-Dec-21 Client Authenticati..  Google Trust Servic...
Trusted Publishers [/ GlobalSign Root CA GlobalSign Root CA 28-Jan-28 <All> <None>
I Untrusted Certificates [ GlobalSign Root CA GlobalSign Root CA 28-Jan-28 Client Authenticati... ~ GlobalSign Root CA...
I Third-Party Root Certification Authoritie 5] Go Daddy Class 2 Certification ... Go Daddy Class 2 Certification Au... 29-Jun-34 Client Authenticati..  Go Daddy Class 2 C...
| Trusted People ) Go Daddy Root Certificate Auth... Go Daddy Root Certificate Author...  01-Jan-33 Client Authenticati..  Go Daddy Root Cer...
| Client Authentication lssuers EglHotspot 2.0 Trust Root CA - 03 Hetspot 2.0 Trust Root CA - 02 08-Dec-43 Client Authenticati.. Hotspot 20 Trust R...
| Other People EglldenTrust Commercial Root CA 1 IdenTrust Commercial Root CA 1 16-Jan-34 Client Authenticati... ldenTrust Commerc...
| Local NonRemovable Certificates E2/ISRG Root X1 ISRG Reet X1 04-Jun-35 Client Authenticati... 1SRG Root X1
| MSIEHistoryJournal KUARIO
| Certificate Enrolment Requests ClKuarie Print Kuario Print 31-Dec-99 Code Signing <Mone>
"l Smart Card Trusted Roots Z5llocalhost localhost 17-Jan-23 Server Authenticati.,  1IS Express Develop..,
v LGl Certificates (Local Computer) [53) Microsoft Authenticode(tm) Ro... Microsoft Authenticode(tm) Root... 01-Jan-00 Secure Email, Code ... Microsoft Authenti...
Personal 5
- Microsoft ECC Product Root Ce... Microseft ECC Product Root Certi..  27-Feb-432 <All» Microsoft ECC Prod...
v T’”‘?” 3_““ Certification Authorities [ Microsoft ECC Product Root Ce... Microsoft ECC Broduct Root Certi..,  27-Feb-43 <All> Microsoft ECC Prod...
- et ':_;t“t 55 Microsoft ECC TS Root Certifica... Microsoft ECC TS Root Certificate ... 27-Feb-43 <All> Microsoft ECC TS R.
e etification Authorii [ Microsoft Root Authority Microsoft Roat Authority 31-Dec-20 <All> Microsoft Root Aut.
ntermediate Certification Authorities
= Trusted Publishers Lgl Microsoft Root Certificate Auth... Microsoft Root Certificate Authori...  10-May-21 <All» Microsoft Root Cert...
= Untrusted Certificates 5/ Microsoft Root Certificate Auth... Microsoft Root Certificate Authori..,  23-Jun-35 <All> Microsoft Root Cert..,
= Third-Party Raot Certification Authoritie EglMicrosoft Root Certificate Auth... Microsoft Root Certificate Authori...  22-Mar-36 <All> Microsoft Root Cert...
= Trusted People =] Microsoft Time Stamp Root Cer... Microsoft Time Stamp Root Certif...  22-Oct-39 <All>» Microsoft Time Sta...
| Client Authentication Issuers [55]NO LIABILITY ACCEPTED, ()97 ... NO LIABILITY ACCEPTED, ()97 Ve... 08-Jan-04 Time Stamping VeriSign Time Stam...
| Preview Build Roots 2l QuoVadis Root CA 2 QueVadis Root CA 2 24-Nov-31 Client Authenticati.. QueVadis Root CA2
| Test Roots 5/ QuoVadis Root CA 2 G3 QuoVadis Root CA2 G3 12-Jan-42 Client Authenticati.. QuoVadis Root CA...
| AAD Token lssuer gl QuoVadis Root Certification Au... QuoVadis Root Certification Auth...  17-Mar-21 Client Authenticati..  QuoVadis Root Cert..
| Other People v || 5l SecureTrust CA SecureTrust CA 31-Dec-29 Client Authenticati...  Trustwave Cwv
< > < >

Now to continue, please refer to Configuration - NT\Ware UniFlow.

Version 3.024 - 12




Active Directory

Install Active Directory by selecting the 'KUARIO AD Connector Service' componentin the KUARIO Gateway set up.
The AD Connector connects your Active Directory to the gateway, you just need to configure it. Please refer to
'Configuration - Active Directory'[ 28

13 - KUARIO Gateway - https.//kuario.com



Gateway Modules

Gateway Modules

The KUARIO Gateway has 3 modules, User Import, Payment and Print. The User Import module, the Payment and Print
modules are separate modules and will cost you an separate fee.

User Import
The User Import module enables you to export Users to KUARIO. This is done via "CSV files. (See Appendix Bl36). If
you enabled the KUARIO AD Connector Service in the set-up, you can also export your Users from your Active
Directory. (See Active Directory GUI[28). To Import a user you must have an ID that enables your application to identify
the user (we call that the 'externalldentifier’), an email address (this is what KUARIO uses as an identifier)

The "CSV file can be imported in a Membership in the KUARIO manager. (Memberships are groups thata user can be
a member of and that may give that user extra rights or options. See Appendix D on how to create a MembershiplTO‘ﬂ).

This is an separate module for which an separate fee is required!

Payment

The Payment module can execute payments using KUARIO on the basis of the KUARIO membership and external
identifier of the user.

This is an separate module for which an separate fee is required!

Print
The Print module will send every print jobs send by a KUARIO user that is a member of a certain membership to a pre-
defined external print-queue. That job will have an attached user name that is equal to the external identifier.

This is an separate module for which an separate fee is required!
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Configuration

Link the Gateway in KUARIO

The KUARIO Gateway must be set up in KUARIO before it can be used. The KUARIO Gateway must become a part of a
KUARIO Outlet under a KUARIO Site.

Preparation
To manage a KUARIO Site you need to be a Merchant that has Site Management rights.
As a KUARIO Merchant, you can link the Gateway to your Site using the Manager at https.//manager kuario.com/ or by
linking the Site using the service module in the KUARIO App. For more information about creating a KUARIO Site
and /or a KUARIO Outlet, please refer to our KUARIO Manager and KUARIO App manuals and Visual Help guides
respectively at our site.

To become a KUARIO Merchant, please contact us via info@aKUARIO.com.

We can help you with linking your Gateway to a KUARIO Site. Please contact: support@KUARIO.com. You should
include the terminal ID, the preferred language and the preferred currency in your email. Optionally if you have an
existing account, you could also let us know the preferred KUARIO Outlet and your account info.

Put the Gateway in KUARIO
1. Click on the KUARIO Gateway GUI (it should display "ONLINE"). Copy the terminal ID (MAC-address) if you do not
want to use the service module in the KUARIO App. Or scan the QR code using the service module in the KUARIO

app.

€ KUARIO Gateway

terminal not linked to KUARIO outlet yet

2. You can start a demo of the software or continue to set up a fully functional, unlimited production version. Click the
‘demo mode' button for the demo mode and continue with step 3. Or, for the production version, go to step 6.

Please select your demo options

currency |cl:>(3urrer1c:5.r j

language  [cbLanguags -

GENERAL TERMS AND CONDITIONS

In demo mode, every order item will have a price managed by KUARIO. KUARIO is entitled to
change the item prices at any time. Any amount spent in demo mode will not be paid out. KUARIO
does not guarantee refunding of falled order items. KUARIO is not responsible for the management
of this terminal Demo mode can be exited at any time by anyone.

Additionally, see https.//www kuario.com/terms.

[~ accept | cancel

3. Selectthe preferred currency for this demo and the preferred language. Click 'accept’ to accept the terms and
conditions.

15 - KUARIO Gateway - https.//kuario.com
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Please select your demo options

currency  [British Pound (GEP £) |

language |Engli:h {United Kingdom) j

GENERAL TERMS AND CONDITIONS

In demo mode, every order item will have a price managed by KUARIO. KUARIO is entitled to
change the item prices at any time. Any amount spent in demo mode will not be paid out. KUARIO
does not guarantee refunding of falled order items. KUARIO is not responsible for the management
of this terminal Demo mode can be exited at any time by anyone.

Additionally, see https.//www kuario.com/terms.

v accept start demao | cancel |

4. Click 'startdemo’.

€ KUARIO Gateway

linked to outlet:

leave demo

5. From this moment on, your KUARIO Gateway can be used to make demo KUARIO payments. You are finished,
ignore the other steps below.

The demo version is limited on user import, only the first 5 users will be imported from a CSV file or from the AD
import service.

At any point you can end the demo mode by clicking 'leave demo'. You should then continue with step 6 to finish the
configuration.

Link the Gateway in KUARIO
6. Please either scan the terminal ID QR with the service module of the KUARIO App, or copy it on paper to link the

Gateway in the KUARIO Manager (The terminal ID can be found trailing behind 'terminal:’ at the bottom of the
screen, See example at the bottom of this page).
The KUARIO Gateway will be linked as a terminal to a KUARIO Outlet,

7. Open KUARIO Manager and add an Outlet. The Outlet should have type 'Gateway'. Which is not to be confused
with 'Device Gateway"!
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OUTLETS REPORTS MORE v

Info > Terminals » Extra

Outlet name

L 2 My KUARIO Gateway Outlet

Is this outlet active?

-]
CASH REGISTER VENDING MACHINE

R —
COINVALIDATOR GATEWAY

LINK TERMINAL

ENERGY LOCKERS

MULTI CONNECTIVITY

DEVICE GATEWAY

28 Is this outlet for members only?

] KUARIO Direct

© CANCEL NEXT >

8. Give the Outlet a recognisable name. Click 'Next'.

OQUTLETS REPORTS MORE v

v Info > Terminals > Extra
My KUARIO Gateway Outlet

Order terminal
©

Device address

ﬁ Deavice name

k= My KUARIO Gateway Terminal

9. Tick'Order terminal'.
10. At 'Device address' put the terminal address (aka MAC-address) you copied at step 1. Make sure to use the delimiter
token'"’ (colon) between each segment (example AABB:.CC.DDEEEFF) and upper case letters.

11. At 'Device name' enter a recognisable hame for the computer running this app. Click 'Next'.

17 - KUARIO Gateway - https.//kuario.com



= OUTLETS REPORTS MORE v
> > Extra

My KUARIO Gateway Outlet
A MFP Template v

A Default Prijzen v

© CANCEL

12. Click 'Save'.
From this moment on, your KUARIO Gateway can be used to make KUARIO payments.

Your KUARIO Gateway GUI should look like this (both Online and linked to an Outlet):

€ KUARIO Gateway

linked to outlet: My KUARIO Gateway Outlet

KUARIO Gateway GUI - Linked / Ready to use
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Configure the KUARIO Outlet

1. Go to the Outlet settings of your KUARIO Gateway Outlet.

Q

&3 My KUARIO Gateway Outlet

Lockers Too

NI
8
[

®lo]

MCB 1

= Orders

Support

MFP

III'
15

Settings

Our Lockers W Delete

Il

PayPoint

This is the name by which | recognize this device

|/

My KUARIO Gateway Outlet > Settings

Q,
 + ] Enable User Import Gateway
-] Enable Print Gateway
] Enable Payment Gateway

2. Select User Import Gateway if you want to be able to import users.
3. Select Print Gateway when your Users should be able to print to a designated print queue.
4. Select Payment Gateway when they should be able to pay with KUARIO.

Be aware that enabling each of these options will increase your monthly fee.

19 - KUARIO Gateway - https.//kuario.com



If you have enabled Print Gateway, you should enter the exact name of the Windows Print queue. If you also need to
restrict the memberships that are allowed to print, you should list only the memberships here that are allowed to
print.

Note: To restrict printing to a group of Memberships, you must list these Memberships (separated with a semi-
colon ') here!

5. Enter the exact print queue name.

6. If printing to this queue must be restricted list the exact names of the Membership(s) (separated with a semi-colon
" that are allowed to print to this queue (and now must use it).

7. Click 'Save' to store the settings.
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Add /7 Remove Users

Users must be known by KUARIO for them to make payments with the help of KUARIO Gateway. A user in UniFlow is
linked to a user in KUARIO via a Membership. \When you invite users for this Membership, an email will be sentto the
user on a given email address. The user has to accept this Membership to use their KUARIO funds from .

A Membership can have an external identifier. For each user that needs to be able to use their KUARIO fundsin
UniFlow, a Membership with the user's ID as external identifier is required.

To import users from UniFlow to KUARIO (which will automatically invite them) either an Excel ".csv must be used, that
isa ™ .csv file with not comma, but semicolon ;' separated values, this request can then be mailed or placed in the csv
directory where it will upload the user information automatically. Alternatively the users could be added manually
directly in the KUARIO manager.

In UniFlow, you can set up the ID in UniFlow.

When the Membership of this user is removed, the link between UniFlow and KUARIO is removed. From that moment
on the user can no longer see or use their KUARIO funds in UniFlow.
A user can decide to remove this Membership via the KUARIO app.

Import Process
With the import process you will generate an invitation for each user in the import to be a member of the KUARIO
Gateway membership at your Site.
By joining that membership you will be able to pay with the UniFlow solution. To create a membership invitation an
email address of the user is needed and the related .

The user data; and User's email address must be made into a ".csv file. That file is imported into the Gateway by the
KUARIO Plug-in and the invitation mails are sent.

Either the invitation email address is known as a KUARIO user and you can accept the invite directly, or the email
address is not recognized as a KUARIO user and you can register as a KUARIO User with the email address to which
the invitation was sent or if you are an existing user under another email address you can log using that email address
as a KUARIO User and accept the invite in that way. See the flow chart below:

Note: At the end of the process the registered KUARIO membership (accepted or not) will consist of the
invitation Email Address (A) and the , even when the user already has a KUARIO user account that is linked to a
different email address (B) then the invitation Email Address (A).

Import Method
Choose an Import Method. If you need to import many users, you can either import via local CSV or importa CSV file in
the KUARIO Manager. If you only need to add a couple of users you can input those directly using the KUARIO
Manager.
1. Choose the import method; 'Import via local CSV or CSV file via the manager' -> Go to 'Prepare CSV[27Y, 'Direct

Import using the manager' -> Go to 'Import using the KUARIO Manager/[23Y.
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Prepare CSV
For bulk user imports you must use the 'Automatic Import' or the 'Import Request By Email' methods, these require an
Excel "csv file. We will help you to prepare such a file here.

Note: If you do not have MS Excel or do not wish to use it, you can create and edit a standard text file with the
**.csv extension yourself, just make sure the file is semicolon separated.

2. Preferably use your existing system that holds the information of your users to export the user information into a
“csv. If you have that option, create the *csv file and continue with 'Name the CSV File[231.

3. If you do not, create a new text file in notepad.exe

4. Type the text:
"externalldentifier;email;externalldentifierDescription;addExternalldentifier;mutation;startDate Time;endDate Time;s
tatus" These will be the column headers of your file. Each line below is a new row (or record) with member values.

) *Untitled - Notepad — m] *

File Edit Format View Help
lExternalIdantiFiar;Email;ExternalIdanti'FierDescription;addExtEmalIdentifier;mutatiun;startDataTime;endDateTime;status

A B © D E E G H
1 email externalldentifier externalldentifierDescription addExternalldentifier mutation startDateTime endDateTime status
2 ‘ joe@example.com 10091971 <= Joe's ID in the external application 1 add 2022-10-15T00:00 2025-10-15T00:00 _|active

In this example the external ID is 10091971, joe@example.com is the email address to which the KUARIO Membership
invitation is sent, the description is irrelevant for the system, but we will use "<= Joe's ID in the external application” as a
description, and the next column addExternalldentifier must be setto 1 as it means you are using a Gateway. Mutation
should be 'add' as you are adding members, although when you use the csv file locally, this field isignored, it is only
used in the CSV upload method in the KUARIO managerﬁ?ﬁ. Joe will be a member from 10/15/2022 at 00:00 through
10/10/2025 at 00:00. The format is: yyyy-mm-ddThh:mm, so startDate Time will be '2022-10-15T00:00' and
endDateTime '2025-10-15T00:00', Note that the letter "T" must be between the date and time. Finally status should be
‘active’ to make sure the new member is set to active.

5. Add users, in this format (using the example data above, we will provide the line you would add. You must use
your own data): "joe@example.com;10091971;<= Joe's ID in the external application;1;add;2022-10-15T00:00;2025-
10-15T00:00;active”

Your notepad file should look like this if you followed the example:
j — m] *
File Edit Format WView Help

email;externalldentifier;externalldentifierDescription;addExternalldentifier;mutation;startDateTime;endDateTime;status
joe@example.com;10891971;<= Joe's ID in the external application;l;add;2022-19-15T@0:00;2025-10-15T@0:00;active

\
Please change the data to your own data when importing the csv into the KUARIO manager.

6. Go to 'File->SaveAs' and set 'SaveAsType' to 'All Files (*.")".

) save As b4
« v 4 @ > ThisPC » 3D Objects v O Search 3D Objects »
Organize v MNew folder = -
X A
& This PC Mo items match your search.
3D Objects
[ Desktop

[ Documents

‘ Downloads w

File name: ~

Save as type: | All Files (%) o

m

Text Documents (*.bd)
vt
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Name the CSV file

7. Give the file a name, that has meaning for this import, in this example a meaningless generic name
"Membershipimportcsv' is used. Make sure to use 'csv' as extension.

) save As X
« ~ 4 _@ » ThisPC » 3D Objects v O Search 3D Objects »
Organize + New folder = - o
a
I This PC No itemns match your search,
J 3D Objects
[ Desktop

=| Decuments

4 Downloads @

File name: | Membershiplmport.csv -

Save astype: | All Files (7.7) v

~ Hide Folders Encoding: | ANSI v Cancel

8. Optionally you can edit the "csv file, adding or editing the user information in MS Excel. To see how to do this refer
to Appendix A: Edit CSV file in MS Excel[ 36)

If you want to import the CSV file in the KUARIO Manager, please continue to: 'Import using the KUARIO Manager:
Inserting users via a *.CSV file[251.

Note: To export or delete users a ‘csv’ folder exist in %sProgramData%\KUARIO beside the 'ini' and 'log’ folders.
In this ‘csv' folder you will find two sub-folders: ‘delete’ and ‘update’.

Note: These directories are checked every minute while the Gateway is running.
When afile is read, the Gateway tries to send the data to KUARIO.
When this succeeds, the CSV file is deleted. When this fails, you can find the reason in the Gateway log
file: C\ProgramData\KUARIO\log\KUARIOGateway.log .

Import via local CSV
If this is your first time importing users via a CSV file, we recommend you to import just one (test) user before
importing a bulk of users.
If you made an error, and user data was imported incorrectly, please use the same CSV and follow 'Delete via CSV[2H

9. Toadd or update the users, copy the CSV file to the update folder C:\ProgramData\KUARIO\csv\update .

10. After a while the CSV file should have been deleted, then the operation was a success. If not, please email the *.csv
file to support@kKUARIO.com. KUARIO Support will help you finish the import task.

11. All membersin this file will be added, the mutation field is ignored.

12. You have finished the import task.

Delete via local CSV

13. To remove this list of users, place the CSV file (with those users) in the delete folder C:
\ProgramData\KUARIO\csv\ delete.

14. All membersin this file will be removed, the mutation field is ignored.

15. You have finished the remove users task.

Import using the KUARIO Manager

Memberships are groups that a user can be a member of and that may give that user extra rights or options.

Memberships can be used to grant exclusive access to an Outlet, provide a deduction of the product price or

make it possible for the members to use KUARIO as payment source, or lastly to use invoices in stead of direct
payments.

They are also commonly used in combination with KUARIO gateways as (in most cases) they link to the external user
account via the Membership's 'External Identifier'.
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You need to have Site management rights to import users from the KUARIO Manager.
As a Merchant, you can invite users to become a Member of your Site via the KUARIO Manager.

1. Browse to https.//manager.kuario.com
Log in with your KUARIO Merchant credentials.

2.

3. Navigate to the Memberships tab

4. SelectaMembership, or create one if none exist. (See Appendix D: Create a KUARIO Membership[40)
5. Click on next until you find the members list.

¥ Inserting one or more users directly
6. Add members to your membership by adding the email address that they also use for their KUARIO Account.
Confirm with the '+' Plus or 'Add item' button

v Info > & E-Mail » Memberships (Total: 1| Accepted: 0)

Our Group
X IMPORT CSV & DOWNLOAD CSV TEMPLATE i
Q  Search
@ t-mail +
e-mail external identifier Description Gateway BALL
Y  ggreen@mysite.com GGreensldentifier

© CANCEL + SAVE

7. Inthe newly added row, edit the External identifier to represent the identifier of the external program. Make sure
to check the 'Gateway’ box.
8. Repeat this for every user and click the 'save'-button when done.
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¥ Inserting users viaa *.CSV file
9. Another method to insert members is the ".csv import method.
10. Click the 'Import CSV' button.

v Info » « E-Mail » Memberships (Total: 1| Accepted: 0)

Our Group

X IMPORT CSV & DOWNLOAD CSV TEMPLATE i

Q  Search

e-mail external identifier Description Gateway BALL

g.green@mysite.com GGreensldentifier

L

© CANCEL v/ SAVE

11. Select your CSV file and click 'Open'.

€ Open *
1+ <« Documentation » v O Search Source »
Organize v Mew folder Bz« [H e
~ MName Status Date modified Type Size
¥ Quick access
09-01-2019 V2 [} 17-Jan-19 1413 File folder
[ Desktop -+ _
11-10-2017 [} 19-Jan-18 11:37 File folder
¥ Downloads * 12-9-2017 ) 19-Jan-1311:37 File folder
Documents * 13-10-2017 [} 26-Jan-1816:26 File folder
[&] Pictures - 21-7-2017 [} 19-Jan-1811:37 File folder
Kabels Fs 26-9-2017 [a] 19-Jan-1811:37 File folder
Presentation # 31-01-2019 o 31-Jan-19 16:25 File folder
DocuPRO - Embedded Client - for Konica Min Bxample Data o 19-Jan-18 11:37 File folder
@ ImportSample.csv @ 15-May-19 09:52 Microsoft Excel C...

DocuPRO - Embedded Client - for Ricoh
Images

Source

v £ >

File name: [ImportSample.csv ~| | Microsoft Excel Comma Separa - |

| Open | | Cancel ‘

12. You have finished the import task.

0 Note: For more information about the import via the KUARIO manager refer to_ Appendix D in this manuall 40 or
contact KUARIO support.
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NTWare UniFlow

Required before installation

B MS SQL Server Management Studio

B uniFLOW + RPS| 2020 LTS SR4 installation or higher with functioning IIS website

B The instructions of the ‘Installation Notes Generic Budget Connector’ uniFLOW manual) should be executed from
chapter 2 through paragraph 2.3.4.

B uniFLOW Generic Budget Connector (v2.2.0.0 or higher) license

B KUARIO Gateway (v2.0.6 or higher)

B Both KUARIO certificates should be imported from the KUARIO Gateway directory into the "Trusted Root
Certification Authorities certificate store”.
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#* Configuration

In the uniFLOW software the setting at the ‘Budget mgmt. system' page must be configured as followed:

1. Startthe uniFLOW server configuration on the uniFLOW server using this URL: http://localhost/pwserver.
2. Click the 'Server Config.' menu-item.

3. Click the 'Interface’item.

4. Click the ‘Budget mgmt. system'’ page.

The following options should already be preselected at their respective fields:
B Budget Management System-= Universal Budget Manager
B Default Budget Plug-in= uniFLOW Generic Budget Connector

= [m} x

\ SERVER. CONFIGURATION
H
N
A

Interface

N
system

Budget Management System | universal Budget Manager v|

Force Standard Budget System for uniFLOW 1o vl
Senver
Default Budget Plg-in | uniFLOW Generic Budgek Connector (v2.2.3) V|

Web Sarvice URL
Proxy Address:
Chank Certificate
1f 55L is required please enter the fullpath and file name of the certificate
Force SOAP 1.1 [he w
Forces th de the 502 1.1 format
Number Dugits after Daomal Point 4 Dgimal digits b
Customer Code KUARID
User idantification token %LISER.Default_SMTPMalAddresste
Transaction Data Format: ULLISAGE. SERVICEUSAGES: | USAGE. PROV
Abow offine mode™ P »
Maximal Balance Age when offine 5
Alowed charge ratio when offine 10
Allow Zero Transactons Yes d
Supported Transacban Modes™ kit Onby ~
HTTP Timeouk 300000
HTTP Reequest Timeout in ms
HTTP Read Wiite Timeout [100000 |
HTTP Read and wite tmeout in ms
Log Level [Debug |

5. Insertatthe "Web Service URL'field, the IP address of the KUARIO Gateway server, the port number 10059 and
'/BudgetService": This should be:

https.//127.0.0.1:10059/BudgetService

6. Theretry time at 'Pending Transaction retry time' should be set to 5.

7. Insert '%USERDefault_CardNumber%' at the ‘User identification token'field.
8. Insert 'KUARIO' at the ‘Customer Code' field.

9. Selectthe option 'ERROR' at the 'Log Level' field.

10. Click the ‘Save' button.
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Active Directory GUI

Note: Before continuing with this section please make sure that your KUARIO Gateway is now online and
inked! (See Appendix C)[39)

Look for the 'KUARIO AD Connector’ link in the start menu under your KUARIO Gateway entry.
Start the 'KUARIO AD Connector’, a window named 'KUARIO AD Connector service' will now open.
1.

KUARIO AD Connector Service - [templates] — [m] x [
KUARIO AD Connector Service works with templates. You can add, edit and delete templates below. Al templates that are set
active will be processed by the service. If you edit an active template, the service will be stopped first. When ready you will be
asked to start the service again.
name [ descripton source | lastrun actve | ]:gu template...
Copy template. .
é Add template X
FRzare= Template name myNewTemplate
Edit template.. Template description  [My new template
Template active:
Tempie sl [Y
Cancel
cose |
. . . .
1. Click Add Template.. 2. Enter the template's name and description,click OK
KUARIO AD Connector Service - [templates] - o X KUARIO AD Connector Service - [templates] — a X

KUARIO AD Connector Service works with templates. You can add, edit and delete templates below. All templates that are set
active will be processed by the service. If you edit an active template, the service wil be stopped first. When ready you will be
asked to start the service again.

KUARIO AD Connector Service works with templates. You can add, edit and delete templates below. All templates that are set
active will be processed by the service. If you edit an active template, the service will be stopped first, When ready you will be
asked to start the service again.

last run Add template... . description last run Add template...
) Copy template. .. Copy template. ..
Delete template. .. Delete template. ..

Edit template... Edit template... |,
Edit propertes. .. Edit propertes...

o= |

3. Select your template. 4. Click 'Edit Template'.

Close

KUARIO AD Cennector Service - [templates] - [m] X KUARIO AD Connector Service - [templates] - [m] x

LDAP settings

Select a source where you want your data to be imported from. Press next afterwards to go to the settings for your selected source. . ‘
server

Template description

[~ Anonymous Login

LDAP base path [ | Fetch DNs [~ usessL

Example: OU=Users,OU=KUARTO,DC=KUARIO,DC =local X
Select data import source LDAP dialect
User name [ Active Directory -
' LDAP server
E £ sV file I ==t [ £ Fetch used attributes
LDAP port 389 LDAP version 3 Preview data {* Fetch all attributes
Import interval (seconds, minimum 30) 300 Custom fiter ‘
LDAP server - specifies IP address or DNS name of the destination LDAP server,
LDAP part - a TCP/IP port used to connect to the destination LDAP server,
Usuzlly there are two standard ports used by an LDAP server to listen to:
o 389 - For regular connections {non-secured)
% o 636 - For secured connections (S5L)
However, in some cases a system administrator may configure a server to listen to another port type.
LDAP version - specifies the version of protocol to be used to perform all operations with the server. The version can be either 2 or 3.
Version 2is deprecated and has to be used only to connect to old LDAP servers, such as UMICH and OpenlLDAP 1.X. In most cases the version
should be 3.
LDAP base path - the oot point to bind to the server. In case with LDAPY3 servers you can leave this field empty to connect to the server RootDSE,
Fetch DNs - usually LDAPY3 servers publish their list of the top level contexts available. To get this list, just press the button. Note: If you
connect to an LDAPY2 server, you have to know your naming context to bind to.
Cancel | | Next ‘ ‘ Cancel ‘ Previous | ‘ Next =|
5. Confirm or edit the template's description, click Next. 6. Fetch the DN's, and enter the user name and password.
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KUARIO AD Connector Service - [templates] - [m]

LDAP settings:

LDAP server [10.0.30.254 B e
LDAP base path |pc=md,ne=inepro,oclocal =] _ FetchDNs I~ UseSsL
Example: OU=Users,0U=KUARIO,DC =KLIARIO, DC =local
LDAP dialect
User name [rrpvadministrator Active Directory -
§ |Passmord [ £ Fetchused attributes
LDAP port 389 LDAP version 3 Preview datal :E ¥ Fetch all attributes
Custom filter [

LDAP server - specifies IP address or DNS name of the destination LDAP server

LDAP port - 3 TCR/IP port used to connect to the destination LDAP server,

Usually there are two standard ports used by an LDAP server to listen to:

o 389 - For regular connections (non-secured)

o 63 - For secured connections (S5L)

However, in some cases & system administrator may configure 2 server to listen to anather part type,

LDAP version - specifies the version of protocal to be used to perform all operations with the server. The version can be either 2or 3.

Version 2 is deprecated and has to be used only to cornect to old LDAP servers, such as UMICH and OpenLDAP 1.X. In most cases the version
shouid be 3.

LDAP base path - the oot point to bind to the server. In case with LDAPv3 servers you can leave this field empty to connect to the server RootDSE

Fetch Die -usually LDAPY3 servers publish therr st of the top level contexts avalable. To get this list, just press the button. Note: If you
connect to an LDAPV2 server, you have to know your naming context to bind to.

accountExpires adminCount A
4 % }72036854775807 v
< >

Cancel | Previous ‘ Next |

7. Click 'Preview' to preview a sample of the data.

KUARIO AD Connector Service - | - O

[Exampie Membersnip | W Fixed KUARIO value:
Email [mad |
[sAMaccounthame ] I

-]

Subscription

External Identifier

Start Time

End Time

External Identifier Description
Add External Identifier

= At ‘Subscription’ a KUARIO Membership is chosen.
Make sure the ‘Fixed KUARIO Value’ box is ticked.

Status

Note: Make sure that before this step your KUARIO
Gateway is now online and linked!

9. Set up the link fields. Make sure to use a fixed KUARIO value.

Refer to 'Appendix A: Using fixed KUARIO values'[ 3 for more
information.

Confirm x

The AD Connector service was stopped during editing of the templates,
Do you want to start the service again?

11. Reboot the service
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KUARIO AD Connector Service - [templates] - [m)

Select the fields you want to use in the import, Just select the fields you really need, to speed up the import process.

labeledURT "
IlastnownParent
lastLogoff mail
Jastiogon
Iast_ogonTimestamp
legacyExchangeDN
ImPwdistory
localelD
lockoutTime
IoginShell
logonCount
logonHours
logonworkstation

| mail

ngﬁagedobjecls
nidhager

masteredy

maxStorage

memberOf

mhsORAddress

middleName

mobile

modifyTmeStamp
msCOM-PartitionSettink
msCOM-UserLink
msCOM-UserPartitionSetlink
msDFSR-ComputerReferenceBl
msDFSR-MemberReferencesl.
msDRM-IdentityCertificate
msDS-AlowedToActOnBehalfOfOtherIdentity
msDS-AlowedToDelegateTo
msDS-Approx-Immed-Subordinates
msDS-AssignedAuthNPolicy
msDS-AssignedAuthiPolicySio
msDS-AuthenticatedAtDC
msDS-AuthenticatedToAccountiist .
manS-AnithMPAlieuSilnMemhar <RI

Currently selected fields:

sAMAccountMame

Cancel “ Frevious | MNext |

8. Select the fields with the email, membership and External
Identifier data. You will need these at the next step.

KUARIO AD Connector Service - [templates] - [m]

Al settings are completed. Press Finish to save the changes and dose the template edit sareen.
¥ Template active
Import data
[~ Always process all import data again

@ Changed since lastimported record (24-Sep-19 16:46:05)

" Once All
| [1s:48:05 =

5 " Changed since

[24-5ep-19
Last update offset (in minutes)

Format of dates in text fields

yyyy-mm-dd

I Log successfully imported records

Cancel Previous Finish

10. Make sure the template is set to 'Active’ and select the way
how the import data should be handled. Click ‘Finish'.



Testing

L& Testing the configuration

£¥ Check the log files

Make sure to check the log files for error messages.

Useful log files:

The KUARIO Gateway is the link between the KUARIO plug-in and
KUARIO Gateway %ProgramData?%\KUARIO\log\KUARIOGateway.log the KUARIO Cloud Payment service. In this log you will find all the

relevant process messages.
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Troubleshooting

Troubleshooting

Sometimes things do not work out as expected, if so please read through this section before contacting your service
organisation or dealer. Chances are you are able to solve the issue yourself.

The section is set up in a Symptom - Prognosis - Resolution format, that is; first the symptom is given, then the possible
causes and then the resolution for those causes.

More information about why a process might have gone wrong can be found in the log files, scroll to the end of this
section to learn more.

Prognosis: There is no (reliable) connection from the KUARIO Gateway to KUARIO

Resolution:
A - Check if the KUARIO Gateway Service can connect to KUARIO.
1)  Browse to 'https.//kuario.com/' on the same machine to make sure requests to KUARIO are not blocked.
a) Ifyou can't, the connection is blocked.
b) Check your firewall and security settings to see if KUARIO is blocked or try to solve this issue with your
network manager.

Prognosis: The KUARIO Gateway is not (yet) linked to a KUARIO Outlet

Resolution:
B - Check if the Gateway is linked to an Outlet
1) Ifthe terminal is not yet linked, please follow this section of the manual to link the terminal[ 151

Prognosis: The KUARIO User is not a part of the Membership

Resolution:

C - Make sure the Membership process has been concluded successfully.
1)  The KUARIO User is not yet invited for the Membership.

a) Invite the KUARIO User for the Membership.
2)  The KUARIO User has not (yet) excepted the Membership.

a) Remember the KUARIO User to accept the Membership.

b) Login asthe userin the KUARIO App or on the KUARIO website.

¢) Navigate to Settings -> Account -> Memberships

d) Checkifthere are any Unapproved Memberships

e) Confirm that the KUARIO User has accepted the Membership. If not remind him again.
3) Ifthe process cannot be completed successfully, ask for help with the Membership request with KUARIO

Support.

Prognosis: The KUARIO User is invited for a Membership under the wrong KUARIO Site.

Resolution:
D - The KUARIO User is invited for a Membership under the wrong KUARIO Site.
1)  Make sure the invitation is sent from the correct KUARIO Site.
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Symptom(s): | had a import configuration error, that | resolved but now the users are still
not imported
Prognosis: Users that failed to be imported will not be tried in future runs
Resolution:
E - Set the import date back before any failed tries
1)  Setthe import date to a date prior to the imports that failed because of the faulty configuration. Select 'Changed
since' and set the date.

KUARIO AD Connector Service - [templates] — [m] X F

Al settings are completed. Press Finish to save the changes and dose the template edit screen.
[¥ Template active

Import data
[~ Always process all import data again

(+ Changed since last imported record (24-52p-19 16:46:05)
" Once All

" Changed since |Z—-Ssn-:,ﬂ J ‘:6:-3:-35 =
Last update offset {in minutes) 1
Format of dates in text fields yyyy-mm-dd

I Log successfully imported records

Cancel Previous Finish

2) Startthe import process again.

Symptom(s): Other issues
Prognosis: This issue cannot be solved without external help

Resolution:

F - Please open the log files.
1) Ifafter carefully examining these files, the issue cannot be resolves by you or your team, please contact KUARIO

support (support@KUARIO.com) to help you further on your way.
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Log files

If you run into trouble please examine these files carefully as they should contain very useful information.

Useful log files:
The KUARIO Gateway is the link between the KUARIO plug-in and
KUARIO Gateway J%ProgrambData%\KUARIO\log\KUARIOGateway.log the KUARIO Cloud Payment service. In this log you will find all the

relevant process messages.

33 - KUARIO Gateway - https.//kuario.com



Appendix A: Using fixed KUARIO values

Appendix A: Using fixed KUARIO values

Warning: Before continuing with this section please make sure that your KUARIO Gateway is now online and

linked! (See Appendix C)[39

In the KUARIO Active Directory Connector you should leave the 'fixed KUARIO value' box ticked.

KUARIO AD Connector Service - | - D X Value Descrlptlon

. The KUARIO Membership, make sure the name |
Subscription Bxampe Membersnp | W fixed KUARIO value Subscription an exact match. P
E-mail | mad =l Email The mail field in Active Directory
External Identifier SAMACcountame - External Identifier ;h\‘fA iﬁsgr&iiﬁaegwtleﬂer, we recommend
Start Time > . . p .
. e Start Time gf';evgﬁ;e / time after which the membership will
ool deniierDescion 5 At 'Sybscription” a KUARIO Membership is chosen. End Time ghej datl'ed/ time after which the membership will
Add External Identifier e G P einvali
Status 7 Make sure the ‘Fixed KUARTO Value’ box is ticked. External Identifier Description A description of the External Identifier

. Use the externalidentifier to create payments S
Add External Identifier to 1 because you are using KUARIO Gateway.
Status Membership status. Has a fixed value either 0
(Active), 1 (Blocked) or 2 (Pending)

Note: Status 0 means active!
Status 1 means blocked!

The 'Subscription' refers to KUARIO memberships. KUARIO Memberships are part of their site. When you connect
KUARIO Gateway to a site, you have access to the memberships of that site.

Memberships
Memberships are groups thata user can be a member of and that may give that user extra rights or options.

Memberships can be used to grant exclusive access to an Outlet, provide a deduction of the product price or

make it possible for the members to use KUARIO as payment source, or lastly to use invoices in stead of direct
payments.

They are also commonly used in combination with KUARIO gateways as (in most cases) they link to the external user
account via the Membership's 'External Identifier'.
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1. Selecta membership from the 'Subscription combo box'.

Site

F—

Site Site
Linked Site
Site Site Site Site
-
Time Zor
Defaull
Site Site Memberships Outlet tnguage
Price (line) Template Ord_er Paym_ent
Terminal Terminal
-+ Device address Pay Box address
- Davicename Pay Boxname
Product Product Product Product Product

2. At'Email’ selectthe Active Directory field that holds the user's email address.
3. At'External Identifier’ enter the External Identifier (an unique non-KUARIO identifier for the user. We recommend
using 'sAMAccountName' (This is the user's log-on name for older Windows OS's).

Membership period

‘startDateTime' and 'endDateTime' are DateTime stamps (by default?) in the 'yyyy-mm-ddThh:mm' format, that indicate
for what period this user is a member of this membership. Before or after this date this user will not be a member of
this membership. This is useful working with users that arrive and/or leave your organisation at a time known
beforehand. Like a student with a membership that grants him access to rooms in his school or university.

4. The'starttime' and 'end time' can be left empty, this means that the membership is forever (or until it is revoked).
5. Atthe 'External Identifier Description’ A description of the sort of identifier for clarity. Like 'Student number' if the
identifier is a student number.

The user's should be in the 'externalldentifier' column). 'addExternalldentifier' should be 1, indicating that you are
using a KUARIO gateway.

6. Set'Add External identifier' to 1" as you are using the KUARIO Gateway.

Status

The last field 'status' allows you to let the member have a non-active status, a member can be active. An active
member can normally use the perks of it's membership. A blocked member cannot use it's membership. The status
'Pending' is used for specific application for the period that the application is evaluating if the user's membership is
granted/revoked. The status 'Pending' is a system status and should not be imported as a value! This field should have
the value 'active’ (or 0) unless instructed otherwise.

7. Setthe status to 0. This means that the membership is active.
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0¥ Appendix B: Edit CSV file in MS Excel

1. Open the created "csv file.

Membershiplmport.csv - Excel

Koos de Graaf

File Home Insert Page Layout Formulas Data Review View Developer Help PDF Architect 6 Creator £ Tell me what you want to do 12 Share I Comments
el 2= y" AutoSum ~
ﬁj & | [caibr LKA | S == ®- BWapTe General - B @ Fj e e} =] Hiesum ?? p
P - Cand | Fi Cell I Del Fi e Sort & Find &
aste = === ==F onditional Formatas Cel nsert Delete Format ort & Fin
BI U~-|FH-|d-A.|=Z==|=3x=|Em & Center = - G 0 .00
. = =" |===1== erge S benter $-%9 W@t Formatting = Table~ Styles + - - - £ Clear~ Filter + Select =
Clipboard T Font o Alignment [F] Number ) Styles Cells Editing -
F2 - k3 ~
A B z D E F G H | 1 K L M N o P Q R s T -
1 |externalldentifier;email;externalldentifierDescription;addExternalldentifier
2 [10091971;| @inepro.com;Studentnummer;1 1
3
4
5 -
Membershiplmport ® ] »
= B o - 1 + 100

2. Like in Notepad headers and values are separated by semicolons. But to comfortably work with these filesin Excel
we will take the next steps.

Membershiplmport.csv - Excel Koos de Graaf
File Home Insert Page Layout Formulas Data Review View Developer Help PDF Architect & Creator £ Tell me what you want te do 1# Share 2 Comments
[BiFrom Text/csv [ Recent Sources P TH Queries & Connectiont [ Import Data x
]
[é From Web ['\ Existing Connections =7
Refresh &« v ‘ + ThisPC » Downloads » « & Search Downloads 2
Data~ S From Table/Range All~
Get & Transform Data Queries & Connections Organize v New folder =~ @ @ ~
A
F2 - F A & This PC
¥ 2D Objects
[ Desktop
A B [« D E 3 G H [£ Documents T [«
1 externalidentifier;email;externalldentifierDescription;addExternalidentifier 4 Downloads wiclib Membershiplmp
. " . . _ ort.csv
2 |10091971; @inepro.com;Studentnummer;1 1! j' Galaxy ST
3 [T h
4
i File pame: | Membershiplmport.csv | [TerFiles cpmrbtres)
Membershipimport (O} Tools ~ Cancel L Y
=) I = ¥ + 100%

Open Excel.

Go to the 'Data’ tab.

Click 'From Text/CSV".

Browse to the created * .csv file.

o X

Mermbershiplmport.csv
File Origin Delimiter Data Type Detection
1252: Western European (Windows) ~ Semicolon - Based on first 200 rows - [Z
externalldentifier email externalldentifierDescription addExternalldentifier

10091971 @inepro.com  Studentnummer 1

null null
[z [] Edit Cancel

7. Excel will automatically detect the format and settings, please check if these are correct and click 'Load".
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AutoSave (® oft) D~ P Search Koos de Graaf KD = — [m] X

File Home Insert Page Layout Formulas Data Review View Developer Help Table Design 12 Share 1 Comments
f e | = — AutoSum v A
ﬁj & an Calibri e VAR E=E e Bwepted General M HE @ Fj &8 =X b= 7Y p Ej
v Fill v
poste. LBICoPY B I UlHolthe Aw | ===|=3= GEv % 9 |9 g Condtional Fomatas Cel Insert Delete Format Sort& Find & | Analyze
v Format Painter = = = ===I== Formatting v Tablev Styles v v v M Filter v Select v Data
& B (] 00 >0 bl 1 OCIear I I
Clipboard [ Font [} Alignment [} Number [} Styles Cells Editing Analysis | A
Ad < fe ~

1 -extemalldentifier -externalldentifierDescription -addExtemaIldentifier ﬂmutation-startbateTime -endDateTime -status

2 example@kuario.com identifier description lor0 add ordel yyyy-mm-ddThh:mm yyyy-mm-ddThh:mm active or pending or blocked

3 aarcher@bestmailclient.com 150 Alberto Archer is a male from Livingston. 0

4

5 -
| membership-import-ManatExample [T < 3

Ready [@ L& Display Settings H |- 1 + 100%

8. The document will now be opened in a way that is easy to scroll trough and to edit.

9. Make sure you only have eight headers and that they are named according to the table above. They should be in
this order and match with the corresponding user data (email should be the user's email address as used in his
KUARIO account. The user's should be in the 'externalldentifier' column). 'addExternalldentifier’ should be 1,
indicating that you are using a KUARIO gateway.

Mutation

The mutation field is ignored when using the local import via CSV. It is used when importing CSV files via the KUARIO
Manager. It should be set to 'add’ when you want the member to be added, and to 'delete’ when you want an existing
user to be deleted. The last three fields (‘startDate Time', ‘'endDateTime' and 'Status') are optional.

Membership period

‘startDateTime' and 'endDateTime' are DateTime stamps (by default?) in the 'yyyy-mm-ddThh:mm' format, that indicate
for what period this user is a member of this membership. Before or after this date this user will not be a member of
this membership. This is useful working with users that arrive and/or leave your organisation at a time known
beforehand. Like a student with a membership that grants him access to rooms in his school or university.
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Status

The last field 'status’ allows you to let the member have a non-active status, a member can be active. An active
member can normally use the perks of it's membership. A blocked member cannot use it's membership. The status
'‘Pending' is used for specific application for the period that the application is evaluating if the user's membership is
granted/revoked. The status '‘Pending’ is a system status and should not be imported as a value! This field should have
the value 'active’ (or 0) unless instructed otherwise.

O Note: The first row (with the headers) is ignored by the import functionality, so this should not contain (user)
import information.

0 Note: Rows with the email address ‘example@kuario.com’ are ignored by the import functionality, so these
should not contain (user) import information.

A Warning: The status 'Pending should not be entered in the ".csv file!

ema|L The emailaddress of the KUARIO User A valid email address.

- =

A description of the sort of identifier for clarity. Like 'Student number' if the

externalldentmerDescnptlon e (58 GG MU,

Atext descnpt|on of the identifier.

Add or Delete this member ‘add’ or 'del
endDateTime The end of a membership period DateTime in format 'yyyy-mm-ddThh:mm'

10. Now add you can add/edit users and check if everything is correctly listed.

11. Remember that the file will become the membership name in KUARIO. So if you need to add to an existing
membership, make sure the name is the exact same.

12. If the document is satisfactory, we can now export it to KUARIO.
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Appendix C: My terminal status

W Status 1; Terminal is not linked to a KUARIO Outlet and is not Online:

€ KUARIO Gateway

terminal not linked to KUARIO outlet yet

B Status 2: Terminal is not linked to a KUARIO but itis online:

€ KUARIO Gateway

terminal not linked to KUARIO outlet yet

W Status 3: Terminal is online and linked to a KUARIO Outlet:

€ KUARIO Gateway

linked to outlet:

leave demo
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Appendix D: Create a KUARIO Membership

Add Membership
1. Open the KUARIO Manager.
Go to Main Menu -> Memberships.

3. Add a Membership, click

Nk

('+ Add’).

Memberships

Version 3024 - 40



4. Name the Membership.
5. Check the box if you want to allow invoicing (by default it should remain unchecked as you would not) want to
allow invoicing).

9 Note: With invoicing your users will to not pay directly, rather their transactions are stored and the Merchant will
be responsible to charge these costs to the user.

6. Ifthe members may enjoy a generic (over all available products) deduction you can enter the deduction
percentage here.
7. Click EEE

Ol KUARIO DASHBOARD  PRODUCTS OUTLETS  TEMPLATES PRICES  REPORTS e Main Square e

Info > Memberships

Our Groyj
S P

B nvoicing allowed D

8. KUARIO Email message, select the language for our default message. Or create your custom message yourself.
9. Click EEEN.

v Info » E-Mail > Memberships (Total: 0 | Accepted: 0)

Our Group

Language New user email
[a]5] English " o

Dear KUARIO invitee,

o

You have been invited to become a special KUARIO Member. Via this
membership you will be able to pay for products & services at different
self-service kiosks

You can accept your membership by;

1. downloading the KUARIO mobile app via your store. Links are at the
bottom of this email

2. register yourself with the same email address we've sent this mail to
3. after registration & opening the app. please accept your membership
via the pop up inside the app.

Note: when you already
become a Special Mem

e a KUARIO account and you want to
you need to accept the invitation via this link.

Regards
The KUARIO Team

© CANCEL NEXT &

10. Add members to your membership by adding the email address that they also use for their KUARIO Account.
Confirm with the '+ Plus or 'Add item' button
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v Info » « E-Mail » Memberships (Total: 1 | Accepted: 0)

Our Group
X IMPORT CSV & DOWNLOAD CSV TEMPLATE i
Q  Search
@ E-mail +
e-mail external identifier Description Gateway BALL
¥  ggreen@mysitecom GGreensldentifier

© CANCEL € BACK v SAVE

11. Another method to insert membersis the ".csvimport method, explained in the next section.
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Import via CSV
12. Click the 'Import CSV' button.

> > Memberships (Total: 1| Accepted: 0)

Our Group

e-mail external identifier Description Gateway

W%  ggreen@mysite.com GGreensldentifier

To Importa CSV file via the manager it should be formatted like this:

externalldentifier;email;externalldentifierDescription;addExternalldentifier;mutation;
startDateTime (yyyy-mm-ddThh:mm) ; endDateTime (yyyy-mm-ddThh:mm) ; status

Gerald Green;g.green@mysite.com;name;0;add;2021-05-01T00:01;2025-05-01T00:01;active

1 |emai| |externa|ldentifier externalldentifierDescription addExternalldentifier mutation startDateTime endDateTime status
2 example@kuario.com identifier description lor0 add or del yyyy-mm-ddThh:mm yyyy-mm-ddThh:mm active or pending or blocked
3 |aarcher@bestmailclient.com AlAr002002 Alberto Archer is a male from Livingston. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
4 bbailey@bestmailclient.com BeBa002003 Beryl Bailey is a female from West Bromwich. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
5 | ccarter@bestmailclient.com ChCa002004 Chris Carter is a male from Crewe. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
6 dcarver@bestmailclient.com DeCa002005 Debby Carver is a female from Morecambe. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
7 echaplin@bestmailclient.com ErCh002006 Ernesto Chaplin is a male from Fochabers. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
8 fchandler@bestmailclient.com FICh002007 Florence Chandler is a female from Kingswinford. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
9 gcooper@bestmailclient.com GoCo002008 Gordon Cooper is a male from Londen. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
10 |hfletcher@bestmailclient.com HeFl002009 Helene Fletcher is a female from Wellingborough. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
11 |ifrobisher@bestmailclient.com IsFr002010 Isaac Frobisher is a male from Manchester. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
12 |jgardner@bestmailclient.com J0Ga002011 Joyce Gardner is a female from Aberdare. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
13 |khooper@bestmailclient.com KiHo002012 Kirk Hooper is a male from Stoke-on-Trent. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
14 |lkellogg@bestmailclient.com LeKe002013 Leslie Kellogg is a female from Swansea. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
15 mleach@bestmailclient.com MilLe002014 Michael Leach is a male from Boston. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
16 nmachin@bestmailclient.com NaMa002015 Nadine Machin is a female from Chesterfield. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
17 |onaylor@bestmailclient.com 0OsNa002016 Oscar Naylor is a male from Sheffield. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
18 |pproctor@bestmailclient.com PaPr002017 Patty Proctor is a female from Huddersfield. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
19 rredman@bestmailclient.com RaRe002018 Rafael Redman is a male from Leicester. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
20 |ssawyer@bestmailclient.com SaSa002019 Sandy Sawyer is a female from Colyton. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
21 |ttrinder@bestmailclient.com ToTr002020 Tony Trinder is a male from Belfast. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
22 |vward@bestmailclient.com VaWa002021 Valerie Ward is a female from Londen. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
23 |wfielder@bestmailclient.com WIiFi002022 William Fielder is a male from Chesterfield. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
24 |afisher@bestmailclient.com AnFi002023 Andrea Fisher is a female from Bolton. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
25 |bforester@bestmailclient.com BaFo0002024 Barry Forester is a male from Chesterfield. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
26 |cgravenor@bestmailclient.com ChGr002025 Chantal Gravenor is a female from St Albans. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
27 |dlocksmith@bestmailclient.com  DelLo002026 Dean Locksmith is a male from Mallaig. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
28 |epaige@bestmailclient.com ErPa002027 Erin Paige is a female from Burry Port. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
29 |fpiper@bestmailclient.com FePi002028 Felix Piper is a male from Oldbury. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
30 |gquilter@bestmailclient.com GaQu002029 Gabrielle Quilter is a female from Bourne End. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
31 |hskinner@bestmailclient.com HuSk002030 Humberto Skinner is a male from Coventry. 1 add 2021-05-01T00:01 2025-05-01T00:01 active
32 liwaxman@bestmailclient.com InWa002031 Ingrid Waxman is a female from Brentwood. 1 add 2021-05-01T00:01 2025-05-01T00:01 active

The example above creates a member identified with email address 'g.green@mysite.com’, with an external identifier
‘Gerald Green', a description 'name’. The external Identifier will be added in the member information, even though
‘addExternalldentifier’ is set to false! The member is not allowed to use KUARIO Gateway, because
‘addExternalldentifier’ is set to 0. Normally ‘addExternalldentifier’ will be setto '1" so the member can use KUARIO
Gateway.

Note: If ‘addExternalldentifier’ is set to 0 the 'externalldentifier' string will still be added to the member
information. However the member is not allowed to use KUARIO Gateway. That means that user can not use
KUARIO as an external payment system, (because it must be linked via his 'externalldentifier’), through a third party
application, using KUARIO Gateway.

Note: Refer to the KUARIO Gateway manual for more information about this.
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mailto:g.green@mysite.com'

13. Select your CSV file and click 'Open’.

X
v O Search Source 2
o @
Date modified Type Size
17-Jan-1914:15 File folder
19-Jan-18 11:37 File folder
19-Jan-1811:37 File folder
26-Jan-18 16:26 File folder
19-Jan-1811:37 File folder
18-Jan-1811:37 File folder
31-Jan-1916:25 File folder
18-Jan-1811:37 File folder
15-May-19 09:52 Microsoft Excel C...

G Open
1 <« Documentation »
Organize v New folder
~
-~ MName Status
s Quick access

9 Desi # 09-01-2019 V2 (=]

eckto)
P 11-10-2017 (=]
{ Downloads -+ 1299017 o
Documents - 13-10-2017 [a)
[&=] Pictures bg 21-7-2017 o}
Kabels - 26-9-2017 ()
Presentation - 31-01-2018 =
DocuPRO - Embedded Client - for Konica Min Example Dsta o

E3:] | rtSample.

DocuPRO - Embedded Client - for Ricoh LSl S 2

Images

Source

v <
File name: | ImportSample.csv

v| Microsoft Excel Comma Separa ~

The members should now be added to your membership.
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Completing creating a new Membership

When you have added the members, it is possible to also add external identifier. An external identifier can be used to
create a subgroup of users in you membership. In the example below two groups are created one has the external ID
'50', the other group has the ID '150". These ID's combined with the membership ID may be exported to external
administrative systems, showing the usage of certain groups without showing their email addresses, thus complying
to privacy concerns.

v Info > ' E-Mail > Memberships (Total: 20 | Accepted: 0)

Our Group
|
Q. Search
@ E | 4=

e-mail external identifier Description Gateway FALL =

E g.green@mysite.com GGreensldentifier

;,,_ aarcher@bestmailclient.com 150 Alberto Archer is a male f (]
;,,, bbailey@bestmailclient.com 150 Beryl Bailey is a female fr O
;,,, ccarter@bestmailclient.com 150 Chris Carter is a male fror  LJ
;,,, onaylor@bestmailclient.com 50 Oscar Naylor is a male frc O
; + pproctor@bestmailclient.com 50 Patty Proctor is a female a
;,._ rredman@bestmailclient.com 50 Rafael Redman is a male (]
;,,, ssawyer@bestmailclient.com 50 Sandy Sawyer is a female (]
;,,, ttrinder@bestmailclient.com 50 Tony Trinder is a male fro O

© CANCEL + SAVE

When a "csv isimported using the startDate Time(yyyy-mm-ddThh:mm), endDate Time(yyyy-mm-ddThh:mm) or status

field, then these fields can also be edited for other members.

14. Tick the check box if you are using KUARIO Gateway, in this case the external identifier must be exactly the same
asthe user's D in the external system connected with KUARIO Gateway.
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v Info > « E-Mail > Memberships (Total: 31 | Accepted: 0)

X IMPORT CsVv

Our Group

& DOWNLOAD CSV TEMPLATE i

Q  Search
@ E-mail +
e-mail external identifier Description Gateway valid from Valid till status

&+ kdgraaf@inepro.com KoosHisExternalld Description ‘ - - Active

=+ aarcher@bestmailclient.. aar002002 Alberto Archer is a 01-05-2021 0001  01-05-2025 00:01  Active

=+ bbailey@bestmailclient. BeBa002003 Beryl Bailey is a fe 01-05-202100:01  01-05-2025 00:01  Active

&_,_ ccarter@bestmailclient... ChCa002004 Chris Carterisam 01-05-202100:01  01-05-2025 00:01  Active

&.‘_ dearver@bestmailclient. pocanozoos Debby Carver s a 01-05-2021 00:01  01-05-2025 00:01  Active

=+ echaplin@bestmailclien.. ErCho02006 Ernesto Chaplin is 01-05-2021 00:01  01-05-2025 00:01  Artive

&_,_ fchandler@bestmailclie.. FICh002007 Florence Chandle 01-05-202100:01  01-05-2025 00:01  Active

&_‘_ gcooper@bestmailclien. GoCo002008 Gordon Cooper is 01-05-202100:01  01-05-2025 00:01 A tive

&_,_ hfletcher@bestmailclie.. HeFl002009 Helene Fletcher is 01-05-2021 00:01  01-05-2025 00:01  Artive
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15. When you need to edit the member period, the member period dialogue will show. Here the startand end of a
period can be determined.



Change member times

aarcher@bestmailclient.com

From date

ﬁ 01-May-202 D 00:01 DISABLE START TIME
Till date

@ )1-May-202¢ (3 00-00 DISABLE END TIME

CANCEL UPDATE

16. Click "2 to save the Membership.

N ‘ KUARIO DASHBOARD PRODUCTS OUTLETS TEMPLATES PRICES REPORTS MEMBERSHIPS

Info > Terminals > Extra

Outlet name

Canteen - Snack Corner -1 [<]

- ]
CASH REGISTER VENDING MACHINE

q

COINVALIDATOR

‘OPERATED PAYPOINT

8 Isthisoutlet private? =0
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Set exclusive access to an Outlet

17. Go to Outlets.

18. Select an Outlet that you want the Membership to have exclusive access to.
19. Tick the box 'Is this Outlet private?'. A pop-up selection list will appear.

20. Select the appropriate Membership(s) from that list.

21. Make sure the box is checked, click

Our Group

22. Click 5

PRODUCTS OUTLETS TEMPLATES PRICES REPORTS MEMBERSHIPS

v Info » & Terminals » Extra

order-terminal

Device address

()
(]
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23. Click 57 to save the Outlet Settings.

PRODUCTS TEMPLATES PRICES REPORTS MEMBERSHIPS

v Info >  Terminals » Extra

24. The Outlet can now only be used by members of the Membership(s) you selected for it. Other users cannot use it.
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